Comprehensive Leave Manager

User Guide

For Microsoft Dynamics® GP Version 2018

**Updated Documentation** visit our [website](https://www.integrity-data.com) to check for updated user guides.
Copyright

Manual copyright 2018 Integrity Data. All rights reserved.

Limitation of Liability

The content of this manual is furnished for informational use only, is subject to change without notice and should not be construed as a commitment by Integrity Data. Integrity Data assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual. Neither Integrity Data nor anyone else who has been involved in the creation, production or delivery of this documentation shall be liable for any indirect, incidental, special, exemplary or consequential damage, including but not limited to any loss of anticipated profit or benefits, resulting from the use of this documentation or sample code.

Publication Date

January 2018
# Table of Contents

Introduction ................................................................................................................................................................ 5
Quick Setup Steps.................................................................................................................................................. 5
Comprehensive Leave Manager Feature Listing ............................................................................................... 5

Installation Overview ................................................................................................................................................. 7
Prerequisite ............................................................................................................................................................ 7
Install Notes ............................................................................................................................................................ 7
Server/Client........................................................................................................................................................... 7
Files Installed ........................................................................................................................................................ 13
Manual Install ....................................................................................................................................................... 13

Registration .............................................................................................................................................................. 15
Activation Manager ............................................................................................................................................. 15
Test and/or Historical Companies .................................................................................................................. 16
Version Information ........................................................................................................................................ 16

Security Settings ...................................................................................................................................................... 17

Setup Windows ........................................................................................................................................................ 20
Attendance Setup Window ................................................................................................................................ 20
Employee Vacation-Sick Time Maintenance Window ..................................................................................... 21
Leave Setup Window ........................................................................................................................................... 22
Leave Code Setup Report .................................................................................................................................... 29
Leave Accrual Schedule Setup Window ............................................................................................................ 31
Leave Maximum Schedule Setup Window ........................................................................................................ 36
FMLA Payroll Setup ............................................................................................................................................. 38

Adding Leave Codes to the Paystub ................................................................................................................... 39
Option 1 ............................................................................................................................................................ 39
Option 2 ............................................................................................................................................................ 39
Option 3 ............................................................................................................................................................ 40
Mekorma Option ............................................................................................................................................. 40

Maintenance Windows ............................................................................................................................................ 42
Employee Leave Maintenance Window .............................................................................................................. 42
Employee Leave Summary Window ................................................................................................................ 49
Employee Leave Transactions Window ........................................................................................................... 51

Transaction/Utility windows ................................................................................................................................... 56
Leave Transaction Entry window ....................................................................................................................... 56
Mass Leave Transaction Entry Window ........................................................................................................... 58
Introduction

Comprehensive Leave Manager allows you to define your own codes and set policies for leave accruals, lump sum allocations and comp time. Save time with mass updating, balance sharing and transfer as well as full Microsoft Web Client integration.

Quick Setup Steps

The following are the quick reference steps necessary to setup Comprehensive Leave Manager and begin processing transactions:

1. The first step in using Comprehensive Leave Manager is to review the company leave policies and determine if a lump sum or accrual schedule would provide the best leave type for the company.

2. Determine the number of leave codes to use to apply the necessary leave policies and begin setting up the leave codes.

3. Assign the leave codes to the employee.

4. Import beginning balances or enter an adjustment for the beginning balances.

5. Run payroll or use the Calculate Leave Accruals window to validate the setups are producing the expected results.

Comprehensive Leave Manager Feature Listing

Unlimited User Defined Leave Codes

Create rules for leave time including: Vacation, Sick, Personal Business, Administrative, Comp Time, Holiday Comp. Rules overlap and integrate to allow complex functions.

Leave Code Transaction History

Displays leave transaction history for any employee. Inspect individual transactions without having to leave the central management window.

Through the Microsoft Web Client, employees may view leave balances, view detailed transaction history and submit leave requests for all leave codes.

Easily Coordinate Sharing of Leave

Comprehensive Leave Manager allows for individual employees or groups of employees to share, donate or transfer time to others.

Additional Features

- Integration with payroll enables up to date information to appear on payroll checks.
- Supports accruals and lump sums.
- Set initial balances for new employees before accrual rules apply.
- Set and manage leave carryover amounts.
• Quickly mass assign leave codes to employees, positions and departments.
• Manage Sick Bank time.
Installation Overview

This section will discuss the prerequisites, list the files installed and go through the install process.

Prerequisite

The prerequisite for Comprehensive Leave Manager is:

- Microsoft Dynamics GP Payroll

Full functionality for Comprehensive Leave Manager also requires:

- Microsoft Dynamics GP Human Resources

Install Notes

Prior to installing complete the steps:

- Confirm all users are logged out of Microsoft Dynamics GP
- Complete all payroll runs and validate no payroll runs are in process
- Make a backup of the Company and Dynamics databases

Server/Client

To install Comprehensive Leave Manager downloaded the exe file from our website. Once the files have been downloaded, you can run them on the Server and/or Client Installations. The product will need to be installed on all machines that process payroll.

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® Components. Creating the Microsoft SQL Server Components needs to be performed on a single computer, typically the server.

1. Right click Integrity Data GP2018 Setup.exe file and select “Run as Administrator”. If you do not see this option, hold the shift key down and right click.
2. Complete the steps in the wizard
3. Verify the GP directory is correct if it is not select Change
4. Select Custom to choose to install only the specific products you purchased.

5. Select Activation Components to only install activation manager files. This option will not install products and it is typically run only to fix an error with activation manager.

6. Select All Components to install all Integrity Data products. The products you did not purchase will register with a 30-day trial period.
If you are upgrading you will be prompted to uninstall the older version, select "y". If you have multiple products, it will uninstall all products.

7. Select the product(s) to install, if installing multiple products, select all that need to be installed.
Custom Setup
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Install to:
C:\Program Files (x86)\Microsoft Dynamics\GP2018\n
If you want to review or change any of your installation settings, click Back. Click Cancel to exit the wizard.

Current Settings:
Setup Type:
  Custom

Destination Folder:
  C:\Program Files (x86)\Microsoft Dynamics\GP2018\n
User Information:
  Name: Windows User
  Company:

9. If prompted to include new code, choose yes.

10. Login as the ‘system administrator’ for each company to create the SQL Server components.

11. The system will auto activate the products you have purchased if you have access to the internet on the machine. If you receive a message Activation Manager failed contact support@integrity-data.com and include a screenshot of the Activation Manager window to receive manual keys.

**BEST PRACTICES**

- Install is not a requirement on the Server; however it is recommended.
- Install updated version on previously installed Client machines.
Files Installed

The files installed for Comprehensive Leave Manager is:

GP Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)
- ELM.cnk or ELM.dic
- Application.IntegrityDataActivation.dll
- Integrity.Registration.Constructor.dll
- IDA6537.cnk
- Integrity.Registration.Addin.dll

Documentation Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Documentation)
- Comprehensive Leave Manager User Guide.pdf

Manual Install

If the user encounters errors during the installation, complete the following steps to manually install Comprehensive Leave Manager:

1. Contact support@integrity-data.com to receive the manual install files for the product(s).
2. Copy and paste the files into the appropriate locations.
   GP Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)
   - ELM.cnk or ELM.dic
   - Application.IntegrityDataActivation.dll
   - Integrity.Registration.Constructor.dll
   - IDA6537.cnk
   - Integrity.Registration.Addin.dll
   Documentation Folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018\Documentation)
   - Comprehensive Leave Manager User Guide.pdf
3. Edit the Dynamics.exe.config
   a. Navigate to the GP folder (C:\Program Files (x86)\Microsoft Dynamics\GP2018)
   b. Backup the Dynamics.exe.config by making a copy and saving the copy **Important**
   c. Open Dynamics.exe.config in Notepad
   d. Find the <addin> and under <Dynamics> copy and paste the following:
      <addin name="IDKeyManagerAddIn"
type="Integrity.Registration.Addin.GPAddln,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/>
   d. Under <DynamicsGPweb> copy and paste the following:
      <addin name="IDKeyManagerAddIn"
type="Integrity.Registration.Addin.GPAddln,Integrity.Registration.Addin,Version=14.0.5.20297,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/>
4. Launch Microsoft Dynamics GP.
5. Login as the ‘system administrator’ for each company to create the SQL Server components.
Registration

The system will automatically activate the product during the login process. If the activation was successful, the user will not receive any messages. However, if the activation process was unsuccessful the user will receive a message. If the activation process fails the user will need to open the Activation Manager window to activate the product.

Activation Manager

Microsoft Dynamics GP > Tools > Setup > System > Activation Manager

The Site Name defaults from the session information on the About Microsoft Dynamics GP window.

From the Product drop-down list the user may select the product they wish to activate and review product information. Once the product is selected the following fields will display:

- Installed Version – Current version number installed.
- Enhancement Plan Date – Date of the enhancement plan expiration.
- Activation Status – Current status of the product.
  - Permanent – Product has been purchased.
  - Trial – Product has been issued a trial period.
  - Deactivated – Product has been deactivated.
- Current Employees – This count defaults from the session information on the About Microsoft Dynamics GP window. The count does not include inactive employees or employees in a Test or Historical company. If the current employee count is incorrect validate Test or Historical companies are named correctly.
• Employees Allowed – The number of employees allowed before the product will be inactivated. If the Current Employees exceeds the Employees Allowed the system will deactivate the product.

The scrolling window contains a list of all companies. By default the product is active for all companies. If the user would like to inactivate a company unmark the company checkbox.

The Auto Activation option may be selected if the user receives a message at login stating the product is not activated. When the user selects the Auto Activation option the system will attempt to automatically activate the product. Once the Auto Activation process is complete the system will display the Activation Messages. For a detailed list of activation messages see the Activation Manager Messages section.

The Manual Activation option is used to manually enter a token. The user would only manually enter a token if they were sent a token by Integrity Data.

Select the OK button to close the window.

**Test and/or Historical Companies**
Registration will not count the active employees in Test or Historical company databases if the Company Name is named correctly, specifically at the end of the Company Name the user must append the following: "<TEST>" or "<HISTORICAL>". See examples below:

- Dextordinary, Inc. <TEST>
- Dextordinary, Inc. <HISTORICAL>

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified.

**Version Information**
To obtain the latest Comprehensive Leave Manager version information, visit our [website](https://www.integritydata.com).

Within Microsoft Dynamics GP verify the version for Comprehensive Leave Manager by selecting the Help Button, select About Microsoft Dynamics GP and then select the Options button. Click OK until the Comprehensive Leave Manager window appears.
Security Settings

The Security Task Setup window may be used to grant or restrict access to the Comprehensive Leave Manager windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, select System, select Security Tasks and enter the system password.

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below:
   - Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User Security), select the appropriate user and make a note of the Security Role ID assigned to the user.
   - Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security Roles), select the Role ID that has been assigned to the user and make note of the Security Task ID assigned to the Role. Use this Task ID to grant security to the Comprehensive Leave Manager.
   
   NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks

2. Select Comprehensive Leave Manager for the Product.

3. Select Windows for the Type and select 3rd Party for the Series.

4. Use the Access List to grant or restrict access to individual items.
   - To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark the item.
   - Click the Mark All button to grant access to all items in the list or click the Unmark All button to restrict access to all items in the list.

5. Click File > Print to print the Security Task Setup Report for the selected Task ID.

6. Choose OK to save your changes.
Comprehensive Leave Manager > Windows > 3rd Party > Access List

- APR Main Menu
- Build IDs
- Calculate Leave Accruals
- Calculate Leave Carry Over Amounts
- Carry Over Builds
- Employee FMLA Calendar
- Employee Leave Maintenance
- Employee Leave Summary
- Employee Leave Transactions
- FMLA Payroll Setup
- Leave Accrual Schedule Setup
- Leave Codes
- Leave Mass Assignment
- Leave Maximum Schedule Setup
- Leave Quick Assignment
- Leave Schedules
- Leave Setup
- Leave Transaction Entry
- Mass Leave Transaction Entry
- Maximum Schedules

Comprehensive Leave Manager > Reports > 3rd Party > Access List

- APR PTO Carry Over Results
- APRPTO Employee Leave Codes
- APR PTO Employee Summary
- APR PTO Employee Trx
- APR PTO Leave Accrual Schedule List
- APR PTO Leave Codes
- APR PTO Leave Max Schedule List
- APR PTO Manual Calculation Results
- FMLA Instance Report
- FMLA Void Check Report
Alternate and Modified Forms and Reports

If desired, select the Comprehensive Leave Manager version of the Microsoft Dynamics GP check, direct deposit and Reprint Pay Stubs reports. The reports contain the standard Microsoft Dynamics GP report plus the Comprehensive Leave Manager balances added to each report.
Setup Windows

Attendance Setup Window

Microsoft Dynamics GP > Tools > Setup > Human Resources > Attendance > Setup

Within the Attendance Setup window, it is recommended that the Accrue Type be set to Payroll. However if it is set to Human Resources the product will function as well.
**Employee Vacation-Sick Time Maintenance Window**

Cards > Payroll > Employee > Vac/Sick button

Use the Employee Vacation-Sick Time Maintenance window to unmark the “Warn When Sick/Vacation Time Available Falls Below Zero”.

Unmarking these options will avoid the warning message “Vacation time available is less than this amount. Do you want to Continue? Yes No” on the Transaction Entry window and the below error messages on the Build Report:

- Sick time available is less than this amount. Do you want to continue?
- Vacation pay hours exceed employee vacation available?

However, with these checkboxes unmarked and a Payroll Transaction Entry is entered for a pay code assigned to leave code the Comprehensive Leave Manager warning “This Pay Code will cause the Leave Balance for Leave Code ‘LEAVE2’ to be negative. Do you want to continue?” will still be prompted during Payroll Transaction Entry. In addition, Comprehensive Leave Manager warnings will be displayed on the Build and Negative Leave Balance Report if an employee takes more time than is available.
Leave Setup Window

Microsoft Dynamics GP > Tools > Setup > Payroll > Leave

The Leave Setup window allows the user to define an unlimited number of Leave Codes that will provide default information when Leave Codes are assigned to employees.

Accrual/Comp Leave Type Window

Select fields on the window are global settings for the Leave Type selected.
• **Leave Code** – Select an existing code or create a new code for the purpose of assigning to an employee. When using Mekorma only the first 7 characters of the leave code appear on the Mekorma check. Thus, if the leave code is longer than 7 characters the employee will only see the first 7 on the check.

• **Description** – Enter a description of the Leave Code which will be available to display in other Comprehensive Leave Manager windows. To hide a leave code from the employee pay check you can add the [HE] attribute to the description. This will prevent the system from printing the leave code on the employee check stub or earnings statement.

• **Leave Type** – Select one of the following options:
  - **Accrual** – Select to define a Leave Code which will accrue time based on a schedule.
  - **Lump Sum** – Select to define a Leave Code which will earn time in lump distributions.
  - **Comp** – Select to define a Leave Code which will earn time by converting select pay during payroll processing.
Inactive – Select to Inactivate a Leave Code so that it may no longer be assigned to an Employee.

Inactive Employees – When the window is activated or upon entry in the Employee ID field, the system will validate that the employee is active. If the employee is not active, the user will be prompted, “This employee ID is inactive.” (Payroll transactions are not processed for Inactive employees)

- Accrual Schedule – Select to assign a Leave Accrual Schedule.
- Accrual Based On – Select to determine what date is used for the purpose of calculating accrual amounts. This option is only available if HR is installed and registered.
  - Hire Date – Hire Date from Employee Maintenance.
  - Adjusted Hire Date – Adjusted Hire Date from Employee Maintenance.
  - Other Date – Select to assign a specific date.
  - Seniority Date– Seniority Date as displayed on Employee Maintenance.
- Accrual Based On Date – Enabled if Accrual Based On is set to Other Date, select to specify a default date to be applied to Employee Leave Maintenance records.
- Effective Date – Select to assign a default date to be applied to Employee Leave Maintenance records. The system will ensure the effective date has been met prior to calculating both Earned and Taken time.
- Calculate Earned Time During Payroll Processing – Select to determine whether to calculate earned time for Employee Leave Codes during normal payroll processing.
- Waiting Period Type – Select to establish a default waiting period to be applied to Employee Leave Maintenance records.
  - None – No waiting period – all Earned Time is made available to the Employee immediately.
  - One Time – Once the Waiting Period Expiration Date has been met, all Earned Time previously Earned as Pending and all future Earned Time is made available to the Employee.
Recurring – Anniversary – Once the Waiting Period Expiration Date has been met, all Earned Time previously Earned as Pending is made available to the Employee, future Earned Time is accrued as Pending and will be made available on the next annual Waiting Period Expiration Date based on the Employee’s Anniversary Date.

Recurring – Other – Once the Waiting Period Expiration Date has been met, all Earned Time previously Earned as Pending is made available to the Employee, future Earned Time is accrued as Pending and will be made available on the next annual Waiting Period Expiration Date.

Recurring – Calendar – Once the Waiting Period has been met, all Earned Time previously earned as Pending is made available to the Employee. The waiting period unit will be applied each year based upon the calendar year.

- Waiting Period Unit – Select the appropriate option from the drop down list.
  - Hours – Enter the number of hours that must be attained before the waiting period expires.
  - Days – Enter the number of days that must pass before the waiting period expires.
  - Date – Enter the date on which the waiting period expires.

- Addition Field – enter the appropriate number of Days or Hours based on your selection for the Waiting Period Unit.

- Conversion Factor – Select to determine the amount that Pay Code hours are factored by when converting to Comp Time. This option is only available for Comp Leave Types.

- Maximum Balance Option – Select to establish a default maximum anytime balance amount for Employee Leave Maintenance records.
  - No Maximum – User may earn an unlimited amount of Leave Time.
  - Fixed Amount – User may earn up to a fixed amount of Leave Time.
  - Use Schedule – User may earn up to a variable amount of Leave Time based on Years Worked.

- Maximum Schedule – Select to establish a default Maximum Schedule for Employee Leave Maintenance records.

- Maximum Hours – Select to establish a default for the maximum amount of Leave Time an Employee may have remaining at any point in time. This option is only available if the Maximum Balance Options is set to “Fixed Amount”.

- Carry Over Option – Select to establish a default option which to be applied to all Employee Leave Maintenance records.

For Accrual Leave Types the Anniversary Date is based on the same date as the “Accrual Based On” date.
o No Carry Over Allowed – Use the Calculate Leave Carry Over Amounts window to remove any remaining balances.

o Carry Over at Calendar Year End – Applies Carry Over Limits annually based on Calendar Year End.

o Carry Over on Anniversary Date – Applies Carry Over Limits annually based on Employee Anniversary Date.

For Accrual Leave Types the Anniversary Date is based on the same date as the “Accrual Based On” date.

o Carry Over on Other Date – Applies Carry Over Limits annually based on the Carry Over Date.

o No Carry Over Limit – Carry Over Limits will not be applied to the Leave Code.

- Carry Over Date – Select the date to apply Carry Over Limits.
- Use Schedule – Select to apply carry over based on years worked.
- Carry Over Maximum Schedule – Enter the schedule to be used for the Carry Over Maximum. This uses the same window as the Maximum Schedule, so best practice would be to differentiate the two types of schedules either in the “Schedule Code” or “Schedule Description” field.
- Carry Over Maximum Hours – Number of hours remaining for Employee Leave Code balance. This is only available for the “Fixed Amount” Carry Over Balance Option.
- Transfer Excess to Leave Code – Enter the Leave code to which Carry Over excess hours are to be transferred.
- Apply Carry Over During Payroll Processing – Select to determine whether or not to apply Carry Over Limits during payroll processing. This option is not available if the Carry Over Option is set to “No Carry Over Allowed” or “No Carry Over Limit”.
- Apply Carry Over During Manual Processing – Select to determine whether or not to apply Carry Over Limits during processing from the Calculate Leave Accruals Window. This option is not available if the Carry Over Option is set to “No Carry Over Allowed” or “No Carry Over Limit”.
- Frequency – Select to establish a default frequency. Applies to Lump Sum leave types only.
  - By Dates - Enter specific month/day/year to earn lump sum amount.
  - Monthly - Defaults first day of the month. For semi-monthly add additional Dates.

To setup bi-weekly lump sum enter bi-weekly dates at the beginning of each year. It is recommended to set a reminder to change the dates yearly.
o Quarterly - Enter specific month/day to earn lump sum amounts. Defaults to the first day of a calendar quarter.

o Annually - Enter specific month/day to earn lump sum amounts. Defaults to the system month/day.

o Accrual Based On – Defaults the employee accrual based on month/day. The system will then accrue the leave time on the accrual based on date every year.

o Recurring – Enter the start date and the system will calculate the next recurring date based on the days entered. For example, if payroll is run bi-weekly enter the pay period start date then set the days to 14. The system will enter the pay period start date for the rest of the year.
  - Days – Enter the number of days for calculating the recurring dates.
  - Auto calculate next year’s posting at year end – Select to auto calculate next year’s posting date when the year end wage file is created. When the year end wage file is created you will be prompted, “Do you wish to calculate next year’s lump sum posting dates for employee leave codes? If yes, the system will update the leave setup and leave maintenance with the new posting dates for the next year. If no, the system will not update the posting date.

- Earned Pay Codes Scrolling Window – Select to establish default Earned Pay Codes assigned to an Employee Leave Maintenance record.

Hours processed during payroll for Pay Codes assigned as Earned will be used to calculate accrual amounts for Accrual Leave Types. In addition, Hours processed during payroll for Pay Codes assigned will be converted to Comp Time hours for Comp Leave Types.


o Refresh Button – Refreshes the Earned Pay Codes Scrolling Window.

o Delete Row Button – Removes a previously selected Earned Pay Code.
• Taken Pay Codes Scrolling Window – Select to establish default Taken Pay Codes assigned to an Employee Leave Maintenance record.

Hours processed during payroll for Pay Codes assigned as Earned will be used to calculate accrual amounts for Accrual Leave Types. In addition, Hours processed during payroll for Pay Codes assigned will be converted to Comp Time hours for Comp Leave Types.

  o Refresh Button – Refreshes the Taken Pay Codes Scrolling Window.
  o Delete Row Button – Removes a previously selected Taken Pay Code.

• Save Button – Saves the current Leave Code.
• Clear Button – Clears the window and removes any changes made in the window.
• Delete Button – Deletes the currently selected Leave Code. The system will not allow deleting a Leave Code that is currently assigned to an Employee Leave Maintenance record.
Leave Code Setup Report

- Window Print Button – Select to print the Leave Code Setup Report

Accrual/Comp Leave Type

Lump Sum Leave Type
When changes are made to the following fields, the system will prompt to roll-down changes to active Employee Leave Maintenance records:

- Inactive
- Accrual Schedule
- Accrual Based On
- Accrual Based On Date
- Effective Date
- Carry Over Date
- Maximum Balance Option
- Maximum Schedule
- Maximum Hours
- Lump Sum Posting Dates
- Lump Sum hours to Post
- Earned Pay Codes
- Taken Pay Codes

**Changes made to the Waiting Period Type will not be rolled down.**
**Leave Accrual Schedule Setup Window**

Microsoft Dynamics GP > Tools > Setup > Payroll > Leave Accrual Schedules

The Leave Accrual Schedule Setup window allows the user to define accrual calculation amounts based on company policies that may be assigned to one or more Leave Codes. The user can setup a single or multiple accrual rules for an accrual schedule. An accrual rule can be setup with a start/end period for a specific rule number. For example, if the policy requires a different amount of leave time for the first year of hire, you can setup one accrual rule for the first year of Employment. Then, a second accrual rule for after the first year of hire. The system will have one accrual schedule and two rules. When the employee has met the requirements of one rule, the system will automatically move them to the appropriate rule.

In addition to assigning multiple rules to a single accrual schedule, you can setup multiple ranges. For example, if an employee must work 0-5 year and 32 hours to receive a designated amount of leave you can setup two ranges. One range for the years of service and other for the hours worked.

If a policy states a certain employee class may receive a bonus of vacation time at the beginning of the year in addition to their regular accrual, you can setup one leave code with two accrual rules. The first rule would define their standard accrual and a second rule could be entered for the annual lump sum amount the employee receives.

For specifics on how to setup different scenarios check out the [KB articles](#):

Leave Accrual Schedules may be assigned to Leave Setup and Employee Leave Maintenance records.

Accrual Schedule
Lump Sum Accrual Schedule
Schedule Code—Select an existing code or create a new code for the purpose of assigning to a Leave Setup record or Employee Leave Maintenance record.

- Schedule Code Lookup – Select to open the Leave Accrual Schedule Lookup Window.
- Schedule Code Record-Level Note – Select to save a note for the currently selected Leave Accrual Schedule.
- Schedule Description – Enter a description for the currently selected Leave Accrual Schedule.

Lump Sum Schedule checkbox – Select to create a schedule to assign to a Lump Sum Leave Code. This option is for simple Lump Sum Calculations. If you want to create multiple accrual rules with multiple lump sum codes or a mixture of lump sum and accrual types use the Accrual leave type and leave this option unmarked.

To create a schedule to assign to a Lump Sum Leave Type the Lump Sum Schedule checkbox must be marked. Lump Sum Accrual Schedules may only be assigned to Lump Sum Leave Codes.

Range 1 or 2 Based On – Select to specify the selection criteria for the currently selected Leave Accrual Schedule. Range 1 is required. Range 2 is optional, if you do not have a range 2 you can select N/A.
- Hours Worked / Pay Period – Select to define a range to and from based on hours worked per pay period. For example, if an employee must work 32 hours per pay period to receive an accrual you would use this option to define the range.

- Hours Worked / Calendar Year – Select to define a range to and from based on hours worked per calendar year.

- Hours Worked Life to Date – Select to define a range to and from based on hours worked life to date.

- Years Worked – Select to define a range to and from based on Years Worked.

- Hours Worked / Accrual Year – Select to define a range to and from based on hours worked per accrual year. The system will use the Accrual Based On Date on the Employee Leave Maintenance window to determine the year.

- Hire to Year End (Month Left) – Select to define a range to and from based on the number of months left in the hire year. For example, if the leave policy states an employee is hired in January – March would receive 24 hours, an employee hired in April – June would receive 16 hours, an employee hired in July – September would receive 8 hours and an employee hired in October – December would receive 0 hours. You would setup the range to Hire to Year End and enter the following ranges:

<table>
<thead>
<tr>
<th>Range 1</th>
<th>Range 2</th>
<th>Calculation Factor</th>
<th>Earned Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>From 0.00</td>
<td>3.00</td>
<td>From 0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3.01</td>
<td>6.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>5.01</td>
<td>9.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>9.01</td>
<td>12.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

- Every X Hours/Calendar Year – Select to define the number of hours an employee must work to receive a certain number of leave hours. For example, if an employee should accrue 1 hour for every 30 hours worked you would use Every X Hour/Calendar Year.

- Hours Worked/Calendar Month – Select to define the number of hours an employee must work to receive a certain number of leave hours in a month. If an employee should accrue 2 hours for working 0-125 hours in a month and 4 hours if they work over 125 hours in a month you could use Hours Worked/Calendar Month. A month is defined by the first day to the last day of the month. For example, the system would calculate the hours worked for the month of January 01/01 – 01/31

- Maximum Hours Based On – Select to specify the criteria used for the purpose of calculating maximum accrual hours. This option is only available for Non Lump Sum Accrual Schedules.

  - Per Pay Period – Variable – Select to apply a maximum based on a variable amount per pay period.

  - Per Pay Period – Fixed – Select to apply a maximum based on a fixed amount per pay period.

  - Per Year – Variable – Select to apply a maximum based on a variable amount per year.
- Per Year – Fixed – Select to apply a maximum based on a fixed amount per year. The system will use the Accrual Based On Date on the Employee Leave Maintenance window to determine the year.
  - Example 1: The system date is 02/08/2010 and the Accrual Based On Date is 02/12/2010; the system will then calculate the year as 02/12/2010 through 2/11/2011.
  - Example 2: The system date is 03/08/2010 and the Accrual Based On Date is 02/12/2010; the system will then calculate the year as 02/12/2010 through 02/11/2010.

- Fixed Maximum Hours – Enter the maximum accrual hours if a fixed amount Maximum Hours Based On option was selected. This option is only available for Non Lump Sum Accrual Schedules.

- Range Scrolling Window
  - Range From – Select the start of the range in either hours or years.
  - Range To – Select the end of the range in either hours or years.
  - Calculation Factor – Enter the amount which will be used to factor included hours. This option is only available for Non Lump Sum Accrual Schedules.
  - Maximum Hours – Enter the maximum accrual hours if the current range from & to are met. This option is only available for Non Lump Sum Accrual Schedules.
  - Earned Hours – Enter the hours to distribute if the current range from & to are met. This option is only available for Lump Sum Accrual Schedules.
  - Refresh Button – Select to refresh the scrolling window.
  - Delete Row Button – Select to delete the currently selected row in the scrolling window.

- Save Button – Select to save the current record.
- Delete Button – Select to delete the current record.

The system will not allow deleting a Leave Accrual Schedule that currently assigned to either a Leave Code Setup record or Employee Leave Maintenance record.
Window Print Button – Select to print the Leave Accrual Schedule List Report.

### Leave Maximum Schedule Setup Window

**Microsoft Dynamics GP > Tools > Setup > Payroll > Leave Maximum Schedules**

The Leave Maximum Schedules Setup window allows the user to define a schedule based on Years Worked for the purpose of limiting the number of Employee Leave Time hours available at any time. Leave Maximum Schedules may be assigned to Leave Code Setup and Employee Leave Maintenance records that have the Maximum Balance Option set to Use Schedule.

- **Schedule Code**—Select an existing code or create a new code for the purpose of assigning to a Leave Setup record or Employee Leave Maintenance record.
  - Schedule Lookup Button – Select to open the Leave Maximum Schedule Lookup Window.
- **Schedule Record Level Note**—Select to save a note for the currently selected record.
- **Schedule Description**—Enter a description for the currently selected Leave Maximum Schedule.
- **Inactive**—Select to inactivate the current leave maximum schedule.
• Maximum Schedule Scrolling Window – Displays the defined ranges and maximum hours.
  o Years Worked From – Enter beginning of a range to base maximum hours.
  o Years Worked To – Enter ending of a range to base maximum hours.
  o Maximum Hours – Enter maximum allowable hours for the selected range.
• Save Button – Saves the current maximum schedule.
• Delete Button – Deletes the current maximum schedule. The system will not allow deleting a Leave Maximum Schedule that currently assigned to either a Leave Code Setup record or Employee Leave Maintenance record.
• Window Print Button – Prints the Leave Maximum Schedule List Report
FMLA Payroll Setup
Microsoft Dynamics GP > Tools > Setup > Human Resources > Benefits and Deductions > FMLA Payroll Setup

The FMLA Payroll Setup window allows the user to assign pay codes to be used to create Family Medical Leave Act (FMLA) Instance from Payroll Transaction.

- Create FMLA Instances from Payroll Transactions [Requires Human Resources] – Mark the checkbox to enable FMLA Pay Codes and Military FMLA Pay Codes scrolling windows.
- FMLA Pay Codes – Select the pay code that will be used in Payroll Transaction Entry to create the FMLA information in Human Resources.
- Military FMLA Pay Codes – Select the pay code that will be used in Payroll Transaction Entry to create the FMLA information in Human Resources.

If you change the system date of the computer on which Human Resources with Integration to Payroll is installed, FMLA benefits won’t be calculated correctly.
Adding Leave Codes to the Paystub

Utilizing Report Writer allows the user to modify the corresponding Employee Check and Earning Statement to include leave code balances. You can even import an existing report that may already have modifications. There are three options for displaying leave codes on the Employee Check and Earnings Statement.

Option 1
The first option is to display only the leave code and available balance on the Employee Check and Earnings Statement. This option uses the HR Time and Attendance Time Code and Time Code Available arrays. With this option, you can use the existing GP report and modify it to include the Time Code Array fields. This option also works with the Mekorma check stubs.

Note: This option is supported with E-Mail Earnings Statements.

Click here for KB article for instructions on using this option.

Option 2
The second option allows the user to choose to calculate and display several fields on the Employee Check and/or Earnings Statement:

Leave code

- This pay period: Earned, Taken, Adjusted, Pending and Available balance
- Year to Date: Earned, Taken, Adjusted and Pending.

The system allows the user to define a year as:

- the accrual year either hire, adjusted hire or other date based on the leave setups
- other date
- Carryover
- Waiting period dates.

- The user can choose which option(s) they would like to display on the check stub. See Option 2 Instructions below for details on how to modify the report for this option.

Note: this option is unsupported with E-Mail Earnings Statements.

Click here for KB article for instructions on using this option.
Option 3

The third option is to display the leave code, pay period earned, pay period taken and current available balance on the Employee Check and/or Earnings Statement. The earned and taken numbers will reflect the current payrolls data; it is not a cumulative number. See Option 3 Instructions below for details on how to modify the report for this option.

Note: This option is supported with E-Mail Earnings Statements.

Click here for KB article for instructions on using this option.

Mekorma Option

If Mekorma is used for the check stub, this option 1 may be used to display the leave code and available balance on the Mekorma check. If you wish to add additional leave time fields to the Mekorma check stub, contact Mekorma directly for information about a customization to the Mekorma check to add additional Leave Balance information.
To add more array values to the Mekorma check you expand the field vertically.
Maintenance Windows

Employee Leave Maintenance Window

Cards > Payroll > Leave

Cards > Payroll > Leave Summary > Leave Code Expansion Button

The Employee Leave Code Maintenance window allows the user to assign Leave Codes created in the Leave Setup Window to specific Employee’s and defines additional information for the purpose of calculating Earned and Taken Leave Time.

Accrual/Comp Leave Type Window
- Employee ID – Select to create or modify an Employee Leave Maintenance record.
  - Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
  - Employee Name – Read-only display from Employee Maintenance.
- Leave Code – Select an existing code or assign a new code to the currently selected employee.
  - Leave Code Lookup Button – Select to enter a Leave Code from the Leave Codes Lookup Window.
  - Leave Description – Read-only display from Leave Setup.
- Leave Type – Read-only display from Leave Setup.
- Inactive – Select to inactivate the currently selected Employee Leave Maintenance record.
• Accrual Schedule – Select to assign a Leave Accrual Schedule for the purpose of calculating earned time.
  
  o Accrual Schedule Lookup Button – Select to enter a Leave Accrual Schedule through the Leave Accrual Schedule Lookup Window.
  
  o Accrual Schedule Description – Read-only display from the Leave Accrual Schedule Setup Window.

• Accrue Through Date – Enter a value to assign the last date time was accrued for the currently selected Employee Leave Maintenance record. System will update this date when accruals are processed through payroll or the Calculate Leave Accrual window.

• Accrual Based On Date – Enabled if Accrual Based On is set to Other Date, select to specify a default date to be applied to Employee Leave Maintenance records.

• Effective Date – Select to assign a default date to be applied to Employee Leave Maintenance records. The system will ensure the effective date has been met prior to calculating both Earned and Taken time.

• Calculate Earned Time During Payroll Processing – Select to determine whether to calculate earned time for Employee Leave Codes during normal payroll processing.

• Waiting Period Type – Select to establish a default waiting period to be applied to Employee Leave Maintenance records.
  
  o None – No waiting period – all Earned Time is made available to the Employee immediately.
  
  o One Time – Once the Waiting Period Expiration Date has been met, all Earned Time previously Earned as Pending and all future Earned Time is made available to the Employee.
  
  o Recurring – Anniversary – Once the Waiting Period Expiration Date has been met, all Earned Time previously Earned as Pending is made available to the Employee, future Earned Time is accrued as Pending and will be made available on the next annual Waiting Period Expiration Date based on the Employees Anniversary Date.

For Accrual Leave Types the Anniversary Date is based on the same date as the “Accrual Based On” date.

• Recurring – Other – Once the Waiting Period Expiration Date has been met, all Earned Time previously Earned as Pending is made available to the Employee, future Earned Time is accrued as Pending and will be made available on the next annual Waiting Period Expiration Date.
• Recurring – Calendar - Once the Waiting Period has been met, all Earned Time previously earned as Pending is made available to the Employee. The waiting period unit will be applied each year based upon the calendar year.

• Waiting Period Unit – Select the appropriate option from the drop down list.
  o Hours – Enter the number of hours that must be attained before the waiting period expires.
  o Days – Enter the number of days that must pass before the waiting period expires.
  o Date – Enter the date on which the waiting period expires.

• Waiting Period Date – If Days or Hours is selected for the Waiting Period Unit the system will use the date entered as the start date. If Date is selected for the Waiting Period Unit the system will use the date entered as the expiration date.

• Addition Field – add the appropriate number of Days or Hours based on your selection for the Waiting Period Unit.

• Conversion Factor – Select to determine the amount that Pay Code hours are factored by when converting to Comp Time. This option is only available for Comp Leave Types.

• Maximum Balance Option – Select to establish a default maximum anytime balance amount for Employee Leave Maintenance records.
  o No Maximum – User may earn an unlimited amount of Leave Time.
  o Fixed Amount – User may earn up to a fixed amount of Leave Time.
  o Use Schedule – User may earn up to a variable amount of Leave Time based on Years Worked.

• Maximum Schedule – Select to establish a default Maximum Schedule for Employee Leave Maintenance records.

• Maximum Hours – Select to establish a default for the maximum amount of Leave Time an Employee may have remaining at any point in time. This option is only available if the Maximum Balance Options is set to “Fixed Amount”.

• Carry Over Option – Read-only display from Leave Setup.
  o No Carry Over Allowed – Use the Calculate Leave Carry Over Amounts window to to remove any remaining balances.
  o Carry Over at Calendar Year End – Applies Carry Over Limits annually based on Calendar Year End.
  o Carry Over on Anniversary Date – Applies Carry Over Limits annually based on Employee Anniversary Date.
Carry Over on Other Date – Applies Carry Over Limits annually based on the Carry Over Date.

No Carry Over Limit – Carry Over Limits will not be applied to the Leave Code.

- Carry Over Date – Select the date to apply Carry Over Limits.
- Use Schedule – Read-only display from Leave Setup.
- Carry Over Maximum Schedule – Read-only display from Leave Setup.
- Carry Over Maximum Hours – Read-only display from Leave Setup.
- Transfer Excess to Leave Code – Read-only display from Leave Setup.
- Apply Carry Over During Payroll Processing – Read-only display from Leave Setup.
- Apply Carry Over During Manual Processing – Read-only display from Leave Setup.
- Earned Pay Codes Scrolling Window – Select Pay Codes to be utilized for the purpose of earning time for the currently selected Employee Leave Maintenance record. This option is not allowed for Lump Sum Leave Types.
  - Refresh Button – Refreshes the Earned Pay Codes Scrolling Window.
  - Delete Row Button – Removes a previously selected Earned Pay Code.
- Taken Pay Codes Scrolling Window – Select Pay Codes to be utilized for the purpose of taking time for the currently selected Employee Leave Maintenance record.
  - Refresh Button – Refreshes the Taken Pay Codes Scrolling Window.
  - Delete Row Button – Removes a previously selected Taken Pay Code.
- Current Balance – Read-only value that displays the current balance of the selected Employee Leave Maintenance record.

For Accrual Leave Types the Anniversary Date is based on the same date as the “Accrual Based On” date.
• Years of Service – Read-only value that is calculated as “Accrual Based On Date” minus the current “User Date”.

• Calendar YTD Hours Worked – Read-only value that is calculated as total hours worked for the current calendar year based on the User Date from payroll transaction history for all currently selected “Earned Pay Codes”.

• Accrual YTD Hours Worked – Read-only value that is calculated as total hours worked for the current accrual year based on the User Date from payroll transaction history for all currently selected “Earned Pay Codes”. Accrual year is determined by the Accrual Based On Date, this could be Hire Date, Adjusted Hire Date, Other Date or Seniority Date.

• LTD Hours Worked – Read-only value that is calculated as total hours worked from payroll transaction history for all currently selected “Earned Pay Codes”.

• Save Button – Saves the current Employee Leave Maintenance record.

• Clear Button – Clears the window and removes any changes made in the window.

• Delete Button – Deletes the currently selected Employee Leave Maintenance record.

> The system will not allow deleting an Employee Leave Maintenance record that has transactional history.

• GOTO Button
  
  o Leave Summary – Select to open the Employee Leave Summary Window.
  
  o Leave Transactions – Select to open the Employee Leave Transactions Window.
- Window Print Button – Select to print the Employee Leave Codes Report.

**Accrual Leave Type**

**Lump Sum Leave Type**
Employee Leave Summary Window

Cards > Payroll > Leave Summary

Cards > Payroll > Leave > GOTO > Leave Summary

The Employee Leave Summary window allows the user to view summary information of Employee Leave Activity.

- **Employee ID** – Select to create or modify an Employee Leave Maintenance record.
  - Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
- **Name** – Read-only display from Employee Maintenance.
- **View Radio Group** – Select to display all Leave Codes currently assigned or only Leave Codes with a balance remaining.
  - All – Select to display all Leave Codes currently assigned to the selected Employee.
  - Balances Only – Select to display only Leave Codes with balances currently assigned to the selected Employee.
- **Method**
  - Calendar – Displays the leave codes for the calendar year specified and sums up the earned, taken, adjusted, remaining and pending for this calendar year.
  - Fiscal - Displays the leave codes for the fiscal year specified and sums up the earned, taken, adjusted, remaining and pending for this fiscal year.
  - All – Displays all leave codes
- **Transaction Dates** – Select to restrict the transactions which display in the scrolling window.
- From – Select to restrict transaction prior to the date entered from displaying in the scrolling window.
- To – Select to restrict transaction after the date entered from displaying in the scrolling window.


  - Leave Code – Read-only from Employee Leave Maintenance.
  - Leave Code Expansion Button – Select to open the Employee Leave Maintenance Window with the currently selected Employee and Leave Code populated in the window.
  - Description – Read-only from Employee Leave Maintenance.
  - Inactive – Read-only from Employee Leave Maintenance.
  - Leave Amounts
    - Earned – Total Earned Time from Employee Leave Transactions.
    - Taken – Total Taken Time from Employee Leave Transactions.
    - Adjusted – Total Adjusted Time from Employee Leave Transactions.
    - Remain – Current Remaining Balance from all Employee Leave Transactions.
    - Pending – Current Pending Balance from all Employee Leave Transactions.

- OK Button – Select to close the window.
- Clear Button – Select to clear the window.
- Redisplay Button – Select to redisplay the calculated values in the window.
- GOTO Button
  - Leave Transactions – Select to open the Employee Leave Transactions Window.

- Window Print Button – Select to print the Employee Leave Summary Report.
The Employee Leave Transactions window allows the user to view detailed transactional information for Employee Leave Maintenance records.

- Employee ID – Select to create or modify an Employee Leave Maintenance record.
- Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
- Name – Read-only display from Employee Maintenance.
- Leave Code – Select an existing code for currently selected employee.
  - Leave Code Lookup Button – Select to enter a Leave Code from the Leave Codes Lookup Window.
  - Leave Description – Read-only display from Leave Setup.
- Leave Type – Read-only from Leave Setup.
- Method
  - Calendar – Displays the leave transactions for the calendar year specified. The system will create a summary transaction for the earned, taken, adjusted, remaining and pending for previous years.
  - Fiscal - Displays the leave transactions for the fiscal year specified. The system will create a summary transaction for the earned, taken, adjusted, remaining and pending for previous years.
  - All – Displays all leave codes
- Transaction Dates – Select to restrict the transactions which display in the scrolling window.
  - From – Select to restrict transaction prior to the date entered from displaying in the scrolling window.
  - To – Select to restrict transaction after the date entered from displaying in the scrolling window.
- Summary Information – Read-only balance information for the currently selected Employee Leave Maintenance record.
  - Total Earned – Total Earned Time from Employee Leave Transactions.
  - Total Taken – Total Taken Time from Employee Leave Transactions.
  - Total Adjusted – Total Adjusted Time from Employee Leave Transactions.
  - Current Balance Remaining – Current Remaining Balance from all Employee Leave Transactions.
  - Current Balance Pending – Current Pending Balance from all Employee Leave Transactions.
- Leave Transaction Scrolling Window
  - Seq # – System generated value based on the chronological order in which it was created.
  - Created Date – User Date at the time the transaction was created.
  - Source – System generated value based on transaction origin.
    - Accrued – Assigned when time accrued during payroll processing.
    - Adjusted – Assigned when Adjustment transactions created from Leave Transaction Entry or Mass Leave Transaction Entry.
- Carry Over Adjustment – Assigned when time adjusted due to a Carry Over Maximum is met either during payroll processing or when Carry Over's are processed through the Calculate Leave Carry Over Amounts Window.

- Comp Earned – Assigned when Comp Leave Time is Earned from Earned Pay Codes during payroll processing.

- From Voided Check – Assigned when time adjusted from a voided payroll check.

- Max Balance Adjustment – Assigned when a Leave Code remaining balance exceeds the Maximum when a payroll is processed.

- Pay Out – Assigned when Pay Out transactions are created in Leave Transaction Entry or Comp Time Earned Pay is paid during payroll processing in excess of Maximum Balances.

- Pending Made Available – Assigned when waiting period expiration date is met during payroll processing.

- Received – Assigned when Transfer transactions are created from Leave Transaction Entry or Mass Leave Transaction Entry (displays for Transfer To Leave Code).

- Taken – Assigned when time is Taken through payroll processing or Taken transactions are created from Leave Transaction Entry or Mass Leave Transaction Entry.

- Transferred – Assigned when Transfer transactions are created from Leave Transaction Entry or Mass Leave Transaction Entry (displays for original Employee Leave Code).

  - Audit Trail Desc
    - Payroll Processing – The system will assign the Audit Trail Code from the employee payroll transactions.
    - Leave Transaction Entry/Mass Leave Transaction Entry – The system will assign the text entered in the “Comment” field.

  - Check #– The system will assign the Check Number from the employee payroll check.

  - Earned – Assigned as the amount earned and made available on the individual transaction.

  - Taken – Assigned as the amount taken on the individual transaction.

  - Adjusted – Assigned as the amount adjusted on the individual transaction.

  - Pending – Assigned as the amount earned as pending on the individual transaction.

  - Balance Remaining – Assigned as the balance remaining after applying the individual transaction.

  - Created By – Assigned as the User ID logged in when the individual transaction was created.

- Transaction Notes – System assigned value to add additional transaction information.

- Create a Transaction Button – Select to open the Leave Transaction Entry Window.
- OK Button – Select to close the window.
- Clear Button – Select to clear the window.
- Redisplay Button – Select to refresh data currently displayed in the window.
- Window Print Button – Select to print the Employee Leave Activity Log Report.

<table>
<thead>
<tr>
<th>Seq</th>
<th>Tr Date</th>
<th>Source</th>
<th>Audit Control</th>
<th>Check</th>
<th>Earned</th>
<th>Taken</th>
<th>Adjusted</th>
<th>Pending</th>
<th>Remaining</th>
<th>Created By</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>04/12/2007</td>
<td>Adjusted</td>
<td>Initial Balance</td>
<td>0.00</td>
<td>0.00</td>
<td>80.00</td>
<td>0.08</td>
<td>80.00</td>
<td>sa</td>
<td></td>
</tr>
</tbody>
</table>
Transaction/Utility windows

Leave Transaction Entry window

Transactions > Payroll > Leave Transaction Entry

The Leave Transaction Entry window allows the user to create leave transactions for Employee Leave Maintenance records to adjust, pay out or transfer Leave Code balances.

- Employee ID – Select to create a transaction for an employee.
  - Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
  - Name – Read-only display from Employee Maintenance.
- Leave Code – Select an existing code for currently selected employee.
  - Leave Code Lookup Button – Select to enter a Leave Code from the Leave Codes Lookup Window.
  - Leave Description – Read-only display from Leave Setup.
- Current Balance Remaining – Read-only value that displays the current balance of the selected Employee Leave Maintenance record.

This window may be used to record different amounts of beginning balances for each employee at implementation of the Comprehensive Leave Manager product.
- **Transaction Type** – Select to create a specific type of transaction.
  - Adjustment – Select to create an adjustment to the available balance or Pending Amount for an Employee Leave Maintenance record.
  - Taken – Select to create a taken transaction for an Employee Leave Maintenance record.
  - Pay Out – Select to create a payroll transaction to pay out Leave Time for an Employee Leave Maintenance record.
  - Transfer – Select to create a Transferred and Received transaction for two Employee Leave Maintenance records.
  - Zero Balance – Select to create a transaction which will set the remaining balance for Pending, Available or both to zero for an Employee Leave Maintenance record.

- **Date** – Select to specify the date for the current transaction.

- **Adjusted Amount** – Select an amount to impact the remaining balance of the transaction in hours.

- **Adjusted Pending Amount** – Select an amount to impact the pending balance of the transaction in hours. This field is only available if Transaction Type Adjustment or Transfer is selected.

- **Adjusted PMA** – Select this to manually move pending time to available. This will create a transaction with the source of Pending Made Available. Enter the pending amount to move and then the earned amount available.

- **Comment** – Enter a comment to display in the Audit Trail Desc field on the Employee Leave Transactions Window.

- **Payroll Batch ID** – Select an existing or enter a new Payroll Batch ID.
  - Batch ID Lookup Button – Select to enter a Batch ID from the Payroll Batch IDs Lookup Window.
  - Batch Description – Read-only description from Payroll Batch Entry.

- **Pay Out Pay Code** – Select a Pay Code which is assigned to the currently selected Employee ID.
  - Pay Code Lookup Button – Select to enter a Pay Code from the Employee Pay Codes Lookup window.
  - Pay Code Description – Read-only description from Pay Code Setup.

- **Pay Out Factor** – Select to factor the Leave Time paid out.

- **Transfer to Employee** – Select to create a "Received" transaction for an employee.
  - Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
  - Name – Read-only display from Employee Maintenance.
• Transfer to Leave Code – Select an existing code for currently selected Transfer to Employee.
  o Leave Code Lookup Button – Select to enter a Leave Code from the Leave Codes Lookup Window.
  o Leave Description – Read-only display from Leave Setup.
• Post Button – Select to post the current transaction.
• Clear Button – Select to clear the window.
• Cancel Button – Select to close the window without posting a transaction.

Mass Leave Transaction Entry Window
Transactions > Payroll > Mass Leave Transaction Entry

The Mass Leave Transaction Entry window allows the user to create Leave Transactions for multiple employees in order to adjust or transfer Employee Leave Maintenance balances.

• Leave Code – Select an active Leave Code which a transaction should be created for.
  o Leave Code Lookup Button – Select to enter a Leave Code from the Leave Codes Lookup Window.
  o Leave Description – Read-only display from Leave Setup.
• Transaction Type – Select to create a specific type of transaction.
- Adjustment – Select to create an adjustment for remaining balance or pending amounts of an Employee Leave Maintenance record.
- Taken – Select to create a taken transaction for an Employee Leave Maintenance record.
- Transfer – Select to create a Transferred and Received transaction for two Employee Leave Maintenance records.
- Zero Balance – Select to create a transaction which will set the remaining balance, pending or both to zero for an Employee Leave Maintenance record.

- Date – Select to specify the date for the current transaction.
- Adjust Amount – Select an amount to impact remaining balance of the transaction in hours.
- Adjust Pending Amount – Select an amount to impact pending balance for transaction in hours.
- Comment – Enter a comment to display in the Audit Trail Desc field on the Employee Leave Transactions Window.
- Transfer to Leave Code – Select an active Leave Code which a “Received” transaction should be created for.
  - Leave Code Lookup Button – Select to enter a Leave Code from the Leave Codes Lookup Window.
  - Leave Description – Read-only display from Leave Setup.
- Department – Select to limit the employee’s listed in the scrolling window by Department.
  - Department Lookup Button – Select to enter a Department from the Departments Lookup Window.
  - Department Description – Read-only description from Department Setup.
- Position – Select to limit the employee’s listed in the scrolling window by Position.
  - Position Lookup Button – Select to enter a Position from the Positions Lookup Window.
  - Position Description – Read-only description from Position Setup.
- Employee Class – Select to limit the employee’s listed in the scrolling window by Employee Class.
  - Employee Class Lookup Button – Select to enter an Employee Class from the Employee Classes Lookup Window.
  - Employee Class Description – Read-only from Employee Class Setup.
- Employees Matching Pay Codes Scrolling Window – Displays a list of all employees with the currently selected Leave Code assigned as active. System will further restrict the list of employees by Transfer to Leave Code, Department, Position and Employee Class. The system will display only employees with both the selected Leave Code and Transfer to Leave Code.
- Include – Select to include the associated Employee ID in the mass transaction.
- Employee ID – Read-only from Employee Maintenance.
- Employee Name – Read-only from Employee Maintenance.
- Current Balance Remaining – Read-only from Employee Leave Code Maintenance Window for the selected Leave Code.
- Refresh Button – Select to refresh the scrolling window.

- Mark All Button – Select to mark all records displayed in the scrolling window.
- Mark None Button – Select to unmark all records displayed in the scrolling window.
- Post Button – Select to post the current transaction.
- Clear Button – Select to clear the window.
- Cancel Button – Select to close the window without posting a transaction.

**Calculate Leave Accruals Window**

Transactions > Payroll > Calculate Leave Accruals

The Calculate Leave Accruals window allows the user to manually create Leave Transactions for Accrual and Lump Sum Leave Types.

- Build ID – Enter an existing or create a new Build ID for the purpose of calculating Leave Accruals
- Build ID Lookup Button – Select to enter a Build ID from the Build IDs Lookup Window.

- Description – Enter a description for the currently selected Build ID.
  - Frequency – Select a frequency for reporting purposes.
    - Weekly
    - Biweekly
    - Semimonthly
    - Monthly
    - Quarterly
    - Semiannually
    - Annually
    - Daily/Miscellaneous

- Calculate Leave Accruals Through – Enter a date to calculate leave accruals through.

For **Accrual Leave Types**, the system will create transactions for all active Employee Leave Maintenance Records for payroll transactions in history which have a Check Date greater than the Accrued Through Date and less than or equal to the Calculate Leave Accruals Through Date. (If the Accrued Through Date is blank, the system will use the Effective Date.)

For **Lump Sum Leave Types**, the system will create transactions for all active Employee Leave Maintenance Records where the Lump Sum Posting Date is greater than the Accrued Through Date and less than or equal to the Calculate Leave Accruals Through Date. (If the Accrued Through Date is blank, the system will use the Effective Date.)

- Employee ID – Enter an Employee ID to restrict the Accrual Results Scrolling Window to only the selected Employee ID.
  - Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
  - Employee Name – Read-only from Employee Maintenance.

- Restrictions – Select to restrict the Accrual Results Scrolling Window.
  - Leave Code
- Department
- Position
- Employee Class

- Available Restrictions Scrolling Window
  - Code – Code from Setup.
  - Description – Description from Setup.

- Add – Select to add the currently selected record from the Available Restrictions Scrolling Window.

- Add All – Select to add all records from the Available Restrictions Scrolling Window.

- Remove – Select to remove the currently selected record from the Selected Restrictions Scrolling Window.

- Remove All – Select to remove all records from the Selected Restrictions Scrolling Window.

- Selected Restrictions Scrolling Window
  - Code – Code from Setup.
  - Description – Description from Setup.

- Accrual Results Scrolling Window
  - Employee ID – Employee ID from Employee Leave Maintenance.
  - Employee Name – Employee Name from Employee Leave Maintenance.
  - Trx Description – Description of calculated transaction.
  - Trx Amount – Amount of calculated transaction.
  - Refresh Button – Select to refresh the Accrual Results Scrolling Window.
  - Delete Row – Select to delete a row in the Accrual Results Scrolling Window.

- Calculate Button – Select to calculate Leave Accrual Amounts. This button enables the Post Button once amounts are calculated.

- Post Button – Select to post amounts from the Accrual Results Scrolling Window.

- Cancel Button – Select to close the window without posting any Leave Accrual transactions.

- Delete Button – Select to delete the currently selected Build ID.
Window Print Button – Select to print the Manual Accrual Calculation Results Report.

<table>
<thead>
<tr>
<th>Leave Code</th>
<th>Description</th>
<th>Trx. Description</th>
<th>Transaction Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>LS</td>
<td>Lump Sum Leave Code</td>
<td>Lump Sum Distribution</td>
<td>60.00</td>
</tr>
<tr>
<td>LUMP</td>
<td>Lump Sum Leave Code</td>
<td>Lump Sum Distribution</td>
<td>60.00</td>
</tr>
<tr>
<td>RLS</td>
<td>Roll down for lump sum</td>
<td>Lump Sum Distribution</td>
<td>150.00</td>
</tr>
</tbody>
</table>
Calculate Leave Carry Over Amounts Window
Microsoft Dynamics GP > Tools > Utilities > Payroll > Apply Leave Carry Over Amounts

The Calculate Leave Carry Over Amounts window allows the user to apply Carry Over Limits as defined in the Leave Setup Window based on the corresponding Carry Over Date from the Employee Leave Maintenance records. The Calculate Leave Carry Over Amounts Window also allows the user to define setup defaults which prevents the necessity to reselect window options each time Carry Over Limits are to be applied.


- Carry Over Build ID – Enter an existing or create a new Build ID for the purpose of applying Carry Over Limits.
  - Carry Over Build ID Lookup Button – Select to enter a Build ID from the Carry Over Builds Lookup Window.
  - Carry Over Build Description – Enter a description for the currently selected Build ID.
- Carry Over Calculation Date – Enter the cutoff date for applying Carry Over Limits.

The system will match Employee Leave Maintenance records with a Carry Over Date prior or equal to the Carry Over Calculation Date for the currently selected Leave Code.
• Restrict to Employee – Enter an Employee ID to restrict the Leave Codes to be Processed scrolling window to only the selected Employee ID.
  
  o Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
  
  o Employee Name – Read-only from Employee Maintenance.

• Leave Codes to be Processed Scrolling Window – Listing of all active Leave Codes without a Carry Over Option set to No Carry Over Limit.
  
  o Include Checkbox – Select to process Carry Over Limits for the corresponding Leave Code.
  
  o Leave Code – Read-only display from Leave Setup.
  
  o Description – Read-only display from Leave Setup.
  
  o Maximum – Read-only display from Leave Setup Carry Over Maximum Hours.
  
  o Refresh Button – Select to refresh the Leave Codes to be Processed scrolling window.

• Carry Over Results Scrolling Window – Listing of all Employee Leave Maintenance balances to be adjusted.
  
  o Employee – Employee ID from Employee Leave Maintenance.
  
  
  o Description– Leave Code Description from Employee Leave Maintenance.
  
  o Current Balance– Current Balance from Employee Leave Maintenance.
  
  o Adjustment – Amount of carry over adjusting transaction.
  
  o Apply to Carry Over – Balance Remaining after applying carry over adjusting transaction.
  
  o Refresh Button – Select to refresh the Carry Over Results Scrolling Window.
  
  o Delete Row Button – Select to delete a row in the Carry Over Results Scrolling Window.

• Calculate Button – Select to calculate Leave Carry Over adjustment amounts for currently selected Leave Codes. This button changes to Post Button once amounts are calculated.

• Post Button – Select to post amounts from the Carry Over Results scrolling window. This button is only available after Calculating Carry Over Adjustments.

• Cancel Button – Select to close the window without posting any Carry Over transactions.

• Delete Button – Select to remove the currently selected Carry Over Build ID.

• Window Print Button – Select to print the Leave Carry Over Calculation Results Report.
Leave Quick Assignment Window
Cards > Payroll > Leave Quick Assignment

The Leave Quick Assignment window allows the user to assign new Leave Code Setup records to an Employee as well as either Activate or Inactivate previously assigned Employee Leave Maintenance records.

- Employee ID – Enter an Employee ID to assign or inactivate Employee Leave Maintenance records.
  - Employee ID Lookup Button – Select to enter an Employee ID from the Employees Lookup Window.
- Name – Read-only from Employee Maintenance.
- Mark All – Select to include all Leave Codes in the Leave Codes scrolling window.
- Unmark All – Select to unmark Leave Codes in the Leave Codes scrolling window that are not already assigned to the selected Employee.
- Leave Codes Scrolling Window – Displays a list of all active Leave Codes from Leave Setup.
  - Include – Select to assign the associated Leave Code to the selected employee.
  - Leave Code – Read-only from Leave Setup.
  - Leave Code Description – Read-only from Leave Setup.
Leave Type – Read-only from Leave Setup.

Effective Date – Defaults in from the Leave Setup record.

Accrued Through – Enter the Accrued Through date for the employees leave code. For more information on the Accrued Through Date see Employee Leave Maintenance window.

Inactive – Select to inactivate an Employee Leave Maintenance record or unmark to activate an Employee Leave Maintenance record.

Refresh Button – Select to refresh the Leave Codes scrolling window.

- Save Button – Select to save the currently selected options.
- Clear Button – Select to clear the currently selected options.

Leave Mass Assignment Window
Microsoft Dynamics GP > Tools > Utilities > Payroll > Leave Mass Assignment

The Leave Mass Assignment window allows users to assign a Leave Code to multiple employees. The user may pare down the list of Employees to include based on Department, Position and Employee Class.

- Leave Code – Select an active Leave Code to mass assign.
  - Leave Description – Display-only from Leave Setup.
• Leave Type – Display-only from Leave Setup.

• Effective Date – Enter a date to default in records marked to Include in the Employees scrolling window.

• Accrued Through – Enter a date to default in records marked to Include in the Employees scrolling window. For more information on the Accrued Through Date see [Employee Leave Maintenance window](#).

• Department – Select to limit the employee’s listed in the Employees scrolling window by Department.
  
  o Department Lookup Button – Select to enter a Department from the Departments Lookup Window.
  
  o Department Description – Read-only description from Department Setup.

• Position – Select to limit the employee’s listed in the Employees scrolling window by Position.
  
  o Position Lookup Button – Select to enter a Position from the Positions Lookup Window.
  
  o Position Description – Read-only description from Position Setup.

• Employee Class – Select to limit the employee’s listed in the Employees scrolling window by Employee Class.
  
  o Employee Class Lookup Button – Select to enter an Employee Class from the Employee Classes Lookup Window.
  
  o Employee Class Description – Read-only from Employee Class Setup.

• Employees Scrolling Window
  
  o Include – Select to assign the Leave Code to the selected employee.
  
  o Employee ID – Read-only from Employee Maintenance.
  
  o Employee Name – Read-only from Employee Maintenance.
  
  o Effective Date – Enter a date to default for Included Employees in the Employees scrolling window.
  
  o Accrued Through – Enter a date to default for Included Employees in the Employees scrolling window. For more information on the Accrued Through Date see [Employee Leave Maintenance window](#).
  
  o Refresh Button – Select to refresh the Employees scrolling window.

• Mark All Button – Select to mark all Employees in the Employees scrolling window.

• Unmark All Button – Select to unmark all Employees in the Employees scrolling window that are not already assigned to the associated employee.
• Update Button – Select to update the records included in the Employees scrolling window.
• Clear Button – Select to clear the window.
**Payroll Processing**

System will process accrual amounts if both of the following are true:

- Payroll End Date > Effective Date
- Payroll End Date > Last Accrual Date

System will convert paid time to comp time and process taken time for all leave types if the following is true:

- Payroll End Date > Effective Date

**Order of Operations**

The system will process Leave Time in the following order:

1. Apply Taken Time
2. Apply Carry Over Limits
3. Convert Paid Hours to Comp Time
4. Calculate Accrual Amounts
5. Apply Maximum Accrual Limits
6. Make Pending Time Available
7. Apply Maximum Balance Limits

**Accrual Calculations**

Hours converted to Comp Time will impact Accrual calculated amounts.

**Comp Time Calculations**

Hours paid in excess of Maximum Balances associated with Comp Leave Codes will be paid during payroll processing and not converted to Comp Time.

---

The system will not accrue time for pay code hours which are converted to Comp Time.

---

**Waiting Period Calculations**

System will apply accrued time as Pending if the Payroll End Date is prior or equal to the Waiting Period Expiration Date. Once the Waiting Period Expiration Date is met, all Pending Time will be made available to the employee. Any time accrued during a pay run that makes Pending Time available, will also be made available to the employee.

**Carry Over Calculations**

The system will reduce the remaining balance based on carry over options selected. This also applies to Comp Time. To ensure comp time is paid out, apply a Maximum Balance instead of a Carry Over Option.
Maximum Balance Calculations
The system will compare the current leave balance remaining, after all other leave calculations have occurred, to the maximum balance. If the current leave balance exceeds the maximum balance, the system will reduce the leave balance remaining by the difference for Accrual and Lump Sum leave types and pay out the difference for Comp leave types.

For Comp Leave Types, if the Balance Remaining exceeded the Maximum Balance prior to the payroll being processed, the system will Pay Out the excess Leave Time using the first Earned Pay Code displayed in the Employee Leave Maintenance Window which is also assigned to the employee as Active in the Employee Pay Code Maintenance Window.

Payroll Processing Reports
During the Payroll Build process the Leave Code Negative Balances report will print. As shown below, this report will show which leave codes will go negative if the payroll is run without changing the transactions affecting the leave.

In addition, Comprehensive Leave Manager will display a message on the Check File Report to indicate that the transaction will exceed the available balance as shown in the report below.
Void Payroll Checks
Leave Time calculated amounts included during payroll processing will be reversed by the Void Payroll Checks process. Pending Time made available to the employee during the pay run, will be returned to Pending status.

Manual Payroll Checks
Leave time calculations are not performed during the Manual Payroll Checks processing.

Multiuser Payroll Integration
When payroll is processed in a multiuser environment it is possible that a given employee may appear in more than one users build. If an employee is in more than one build Comprehensive Leave Manager will detect situations where incorrect or duplicate leave time could potentially be assigned to an employee. Specifically, the system conducts certain edit checks during the build and calculate processes and will determine which builds need to be rebuilt, marking them as “Rebuild Advised”. The system will also conduct similar checks for the calculate leave accruals process. The Rebuild Advisory Report will detail which employees face potential incorrect or duplicate leave time.

For example, employee ACKE0001 is in Mary standard weekly payroll batch. However, Jane is also processing ACKE0001 for a bonus payroll. If Mary builds at the same time Jane builds the system could calculate the leave accrual incorrectly for this employee. In this situation Mary or Jane would receive a message warning of the potential incorrect leave calculation and warning to rebuild.

If the user chooses to go forward with a payrun or posting of leave accruals regardless of the rebuild advisory, then the system will identify posted leave transactions for easy detection in subsequent inquiries. Such a leave transaction will be marked with a Transaction Note of “Non-rebuilt multiuser leave transaction” in Employee Leave Transactions.
Reports

Rebuild Advisory Report
The Rebuild Advisory Report is available during the calculate payroll process and the post leave accruals process. It is designed to alert the user when incorrect or duplicate leave amounts may be assigned to an employee, as a result of that employee being included in multiple builds or having leave accruals calculated multiple times, due to the multiuser payroll functionality in Dynamics GP. The report simply lists the employee ID and name of each employee for which a payroll rebuild or recalculation of leave accruals is suggested.

Lost Time Report
The Lost Time report displays employees who have lost time due to carry over, anytime maximum or negative adjustments.

Enter the option for the report.
Select Calendar, Fiscal or All to determine which year of transactions will display on the report.

Select the Year you wish to report lost transaction types.

Select which the types of transactions to report under the options section.

- Select Include Inactive Employees to print inactive employees on the report.
- Select Zero Balance Trx to print lost time due to a zero balance adjustment.
- Select Fixed Maximum to print lost time due to a fixed maximum adjustment.
- Select Carry Over to print lost time due to a carry over adjustment.
- Select Negative Adjustments to print lost time due to a negative adjustment.

Enter the range of Employees to print on the check.

**Leave Liability SmartList**

The Leave Liability Report provides a way to track the liability that needs to be recorded in the financials each month for outstanding time for each leave code. The report can be filtered by department to allow you to allocate costs accordingly. Download this SmartList here: [http://www.integrity-data.com/faq-items/kb-smartlist-comprehensive-leave-manager/](http://www.integrity-data.com/faq-items/kb-smartlist-comprehensive-leave-manager/)
Leave Transaction and Summary

Import or build SmartList reports based on the Transaction and Summary data in Comprehensive Leave Manager.

Here is our KB article on building SmartList using SmartList Designer:


Here is our KB article on importing five SmartList reports using SmartList Builder:

http://www.integrity-data.com/faq-items/kb-smartlist-comprehensive-leave-manager/
Scenarios

Comprehensive Leave Manager Sick Bank Scenario

Comprehensive Leave Manager allows companies to manage their Sick Bank benefit. How this works:

1. Create a fictitious employee, SICKBANK.
2. Create a Leave Code, SICKBANK within the Leave Setup window.
3. Assign the SICKBANK Leave Code to the SICKBANK Employee within the Employee Leave Maintenance window.
4. Sick time contributions may be transferred from a specific employee and leave code to the SICKBANK bucket by using the Leave Transaction Entry window.

5. The Employee Leave Transactions window may be used to view the received sick bank time.
6. Sick time distributions from the SICKBANK bucket may be transferred to a specific employee by using the Leave Transaction Entry window.

7. The Employee Leave Transactions window may be used to view the transferred sick bank time.
Comprehensive Leave Manager Knowledge Base

For additional information and helpful tips, you can view articles on our website.
Comprehensive Leave Manager Messages

A payroll build cannot be processed because there are unposted leave transactions.
Situation: Potentially there are orphaned records in the work tables.

Solution: The user needs to clear the Payroll Check Work tables. Use the Clear Data window (Microsoft Dynamics GP menu > Maintenance > Clear Data) to remove all data from the Payroll Check Work tables. Note: This will remove all records from the Payroll Check Work tables. Be sure to have a current backup of the company database before clearing the data.

Manual Accruals cannot be processed since a payroll build is in process.
Situation: There is a build in process.

Solution: The user needs to remove the build from within the Build Payroll Checks window.

One or more employees included in the pay run may have incorrect leave balances. You should rebuild the pay run.
Situation: Your build contains an employee being processed by another user. This employee may have incorrect leave balance information if you do not rebuild.

Solution: Rebuild the pay run or proceed with potentially incorrect transactions. The potentially incorrect transactions will be indicated with a note if posted.

One or more employees included in the calculated accruals may have incorrect leave balances. You should recalculate leave accruals.
Situation: Your Leave Build contains an employee being processed by another user. This employee may have incorrect leave balance information if you do not recalculate leave accruals.

Solution: Recalculate accruals or proceed with potentially incorrect leave transactions. The potentially incorrect transactions will be indicated with a note if posted.
FAQs

What is the number of leave codes that can be shown on a paycheck?
You can have up to 24 leave code balances appear on the check stub.

Is Microsoft Dynamics GP Human Resources required to use Comprehensive Leave Manager?
No, only the Payroll module is required.

Can I change a Schedule of a Leave Code attached to an employee at any time? This will be required in case of Promotions and the employee is going to get a different number of hours per pay period.
Yes, a leave code schedule can be changed at any time at the employee level.
Activation Manager Messages

**Activation Failed: Trial invalid or trial period expired**
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

**Activation Failed: Site name does not match this installation**
Situation: The site name does not match the token which was issued.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

**Activation Failed: Product Name does not match this installation**
Situation: The product name does not match the token which was issued for a product.
Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error message displayed so the token can be updated with the correct site name.

**Trial period for Comprehensive Leave Manager has expired**
Situation: The trial period has expired for the product.
Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.

**Employees Allowed has been exceeded**
Situation: The current employee count has exceeded the employees allowed.
Solution: Contact sales@integrity-data.com to upgrade to the next tier.

**Activation Failed: Unable to contact web service. Activate manually or revert to previous product dictionary**
Situation: The system could not make a connection to the web service.
Solution: Contact support@integrity-data.com for assistance.

**Activation Failed: Product has been deactivated**
Situation: The product has been deactivated.
Solution: Contact support@integrity-data.com for assistance.

**Upgrade Failed: Enhancement Plan period expired. Renew Enhancement Plan or revert to previous product version.**
Situation: User attempted to upgrade a product when their enhancement plan was expired.
Solution: Contact sales@integrity-data.com to renew the enhancement plan.

**Comprehensive Leave Manager: Activation Failed**
Situation: Communication breakdown between the user machine and Integrity Data.
Solution: Contact support@integrity-data.com for assistance.
Deactivate Product

There are three ways to deactivate the Comprehensive Leave Manager; disable, inactive or uninstall.

Disable
To disable Comprehensive Leave Manager without having to exit Microsoft Dynamics GP, open the Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, select Customize and then click Customization Status. Select the product from the list and click Disable. The product can be enabled by closing and reopening Microsoft Dynamics GP.

Inactivate
Comprehensive Leave Manager can be inactivated by company, open the Activation Manager window and unmark the company checkbox.

Uninstall
If Comprehensive Leave Manager needs to be uninstalled complete these steps on the server and the client where Comprehensive Leave Manager has been installed.

1. Remove the ELM.DIC file from the Runtime Directory
   Default location is C:\Program Files (x86)\Microsoft Dynamics\GP2018

2. Make a copy of the Dynamics.set file

3. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:
      5627
      Comprehensive Leave Manager
      :C:Program Files (x86)/Microsoft Dynamics/GP/ELM.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP/Data/F5627.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP/Data/R5627.DIC

4. Save the Dynamics.set file

5. Launch Microsoft Dynamics GP and login as the ‘system administrator’
Uninstall Activation Manager

Activation Manager will manage activation for all Integrity Data Products. If you are uninstalling all Integrity Data products, you need to remove the Activation components.

IMPORTANT: If you uninstall one product but have other Integrity Data products do not uninstall the Activation Manager components.

1. Make a copy of the Dynamics.set file
2. Open the Dynamics.set file
   a. Decrease the top number by one:
      For example, if the top number is 21 change it to 20
   b. Remove the following lines from the Dynamics.set file:

      6537
      Integrity Data Activation
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/IDA6537.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537F.DIC
      :C:Program Files (x86)/Microsoft Dynamics/GP2018/Data/IDA6537R.DIC

1. Save the Dynamics.set file

Make a copy of the Dynamics.exe.config file.

3. Edit Dynamics.exe.config and find the line(s) beginning with:
   <addin name=”IDKeyManagerAddin”>

4. Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections.

5. Save the Dynamics.exe.config file

6. Launch Microsoft Dynamics GP and login as the ‘system administrator’
Contact Information

Get quick answers to your questions

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162.

If you have registered your product, Technical Customer Service is available for any customers with a current Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support should always be your VAR (if you have one).

Join our User Groups

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join!

Rate us and our products

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the form on our contact page and leave your quote in the comment section.

Suggest new features or improvements

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our Director of Client Services, at tfranz@integrity-data.com or David, our Product Manager at dwilmert@integrity-data.com. As always, technical ideas and user input are highly encouraged. At Integrity Data, we want to hear your input, so drop us a line!

Browse our solutions

The Integrity Data website is a great place to get additional information on products and services. The following information is available on our website:

- Integrity Data's HR & Payroll software pages include Demos, Features and Benefits, and ROI Calculators
- Visit our Services page to learn more about our additional customization services

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail sales@integrity-data.com.